Packet Operator Type Il

USE AND DISTRIBUTION NOTICE

e Santa Clara County RACES authorization is granted to use and
duplicate this material as-is as long as this page and the
copyright notices on each page are included, acknowledging
Santa Clara County ARES/RACES as the holder of the
copyright.

e Permission is granted to adapt this presentation to your
needs as long as you acknowledge our copyright and include a
note similar to "adapted with permission from Santa Clara
County ARES/RACES”

e For additional information on training or any of our programs
send an email to: info@scc-ares-races.org
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Housekeeping
¢ Introductions FOLLOW/NG
¢ Pen/pencil & paper INSTRUCTIONS

e Cell phones on silent or vibrate

¢ Side conversations

e Restrooms
¢ In case of emergency

© Copyright 2011

a Clara County ARES®/RACES. All rights reserved.

WHAT WA

H LEARN HOW
e Questions 70 READ AN
INSTRUCT/ONS

* Breaks

¢ No wandering or exploring other areas of the building.
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Overview: Packet Classes

Packet Type Ill, Part A Packet Type Ill, Part B

* Role of the Packet Operator Packet Operations

* Packet Network Overview Diagnosing Setup Problems
¢ Packet Network Components Selecting a BBS

* Packet Station HW & SW Creating Messages

.

.

Accessing the Network Event Documentation
Standard Workflow Productivity Hints
Exercises

Packet Type Ill, Part A+
* Packet Operations Self-Paced
Exercise workbook

Packet Type Il: Advanced Techniques, such as County EOC Packet
Station Setup & Operations, Operating without Outpost.

Learning Objectives

At the end of this class, you should be able to:

¢ Understand the setup and operation of the county EOC radio
room packet station

e Set up and use a terminal program to access a BBS

e Without Outpost...
— Connect to a JNOS BBS
— Send and receive plain text messages with BBS commands
— Send and receive PackltForms with BBS commands

A Note on receiving Class Credit

To get credit for this class, there are 3 things that you
need to do:

1. Attend the classroom session.

2. Complete the evaluation by Saturday, one week
after the class. See the instructions at the end of
this material.

3. Complete a short exercise by Saturday, one week
after the class.

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 2
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Fictitious Examples

e We use fictitious call signs in this presentation to
avoid SPAM

e W6XRL4: Herman Munster

e XNDEOC: City of Xanadu Emergency Operations
Center :

10/17/2024

What about Xanadu?

e Xanadu received lasting fame
in the western world thanks
to the Venetian explorer Marco Polo’s
description of it in his celebrated book Travels (c. 1298).

e Distant and mysteriously lost Xanadu, thus, came to represent a
place of mystery, splendid luxury and easy living.

Fortunately, you get to visit Xanadu only during Packet classes and

Packet exercises.

* Only use an XNDxxx tactical call that has been specifically assigned
to you for an exercise or training event and then only for the
duration of that event, including any homework follow-up.

* PLEASE NEVER USE XNDxxx tactical calls during any other time.

Instead, use one of your City’s extra tactical calls for practice (with

your EC’s permission, of course).

How to process high volume traffic efficiently

COUNTY EOC PACKET STATION
SETUP & OPERATIONS

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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¢ Have separate send & receive stations
e Learn to use the automation

— Automated polling every 5 minutes by Telnet
— Automated ICS 309 Logging

¢ Watch message handling order

as possible
¢ Balance outgoing and incoming traffic

Packet Net Operations at County EOC

e County message handling can be non-stop action

¢ Move the messages to the Traffic Manager as quickly

¢ Follow the SCCo Radio Room packet procedures

10/17/2024

SCCo Packet Net

Reference Binder

What'’s inside
¢ There is a “standardized” binder
for every position in the SCC
EOC, including each position in
the RACES radio room.
e General content includes:
— activation and operation
— end-of-shift and demobilization
— Packet-specific activities

DO NOT REMOVE
REPLACE WHEN FINISHED

COUNTY OF SANTA
CLARA

RACES UNIT

PACKET NET

Position Reference Binder

EMERGENCY OPERATIONS CENTER
POISITION REFERENCE MATLRIAL

Msg Traffic
Runner Trays Manager
- TO Verify
P:':;UP H—> Radio ~—> Prioritize

8 Room Route

- Verify
Dell TO

eliver |€—— Prioritize
& Log EOC

Route

perform the traffic manager role

1t 20112024 Sarta Clara County ARESEIRACES. Al igts reserved

County Radio Room Traffic Routing

Radio Room Shift Supervisor

To Net Boxes Net Teams

Message Net

Packet Net

... Other Nets

From Net Boxes

Message Net

Packet Net

... Other Nets

Message

Packet

* For small, low traffic events, radio room supervisor may also

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.




Packet Operator Type Il 10/17/2024

Prioritizing Packet Traffic

Scribe/

Operator
Operator P

Prioritize Prioritize
To Message NetBox — vs. other | vs. On
- Outgoing Incoming The
Traffic Air

Manager Prioritize Prioritize

From Message Net Box <€— vs. other €—— vs.
Incoming Outgoing

Internal notes E a

and messages

e Operator prioritizes message in Outpost
— Holds incoming for high priority outgoing and vice versa

* Scribe/Operator prioritizes & logs message in to & out from the team
— Maintains prioritized incoming and outgoing message bins

¢ Separate Send & Receive stations facilitate processing

. e 13
Santa Clara Couny ARES (i s

County EOC Packet Station Overview

LAN / Fiber / Wi-Fi
I | I

i T "
PC1 PC2 ==
- . \ SCCo

i Automatic R - .
Transmit u (;T:clecssﬁcgewe Printer  Backup Printer RACES
( ) Network

(1)

A Rooftop W1XSC-1
A\ Antenna W2XSC-1
e One PC normally configured for transmit only W3XSC-1

W4XSC-1

e One PC normally configured for (automated) receive
e Either PC can perform both tasks

e Both PCs have a primary and backup printer defined
e Backup TNC/radio can be switched to either PC

OUTPOST

INTERACTING WITH THE BBS
WITHOUT OUTPOST

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 5
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Its all about control with Text Commands

e Simple text commands control the TNC
— MYCALL callsign = set the TNC’s Mycall command to your callsign
— CD software = set Carrier Detect mode to software
— Ccallsign = Connect to station callsign (ax.25 address)
¢ Simple text commands control the BBS mailbox
— SP address = Send a Private message to an address
— LA = List All messages in this area (mailbox)
— R n=Read message number n

e Qutpost simply automates the process of typing the
commands to the TNC (to connect) and then to the BBS
(to send/receive messages)
— Watch the Outpost session window to see what it’s doing
— View the Outpost transaction log later to see what it did
* Actions > View Outpost Data Directories > logs > transactionYYMMDD.log

. 16
i cights reserved

Sidebar: Outpost Logs

w Outpost data directory > logs

15-0ct 9:34:40: Outpost/Opsessn v3.5.0 co: TNC Session # 15-Oct 0a:3.
3019 19

Outpost/Opsessn v3.5.0 c8: THC Session &

15-0ct 09:34140: Using Call Sign KNGPE
sing TNC setup XSC_Kantronics_KPC3-Plus cod

sing BBS setup XSC_WIXSC-1 €an't DISCOMMECT, A Link state is: DISCOMMECTED

nccheck: THC is ok iz

ncInit: Complete as KNGPE BEACON  EVERY O (disabled)

+ BbsConnect: Connected to WIXSC-1 as user cnd:Echo on

ECHO was O

: BbsConnect: B85 is INOS codimy KHGPE

i pdlisen SEL ., — P

B S——— =

STREAMEV Was OFF

cmd:STREAMSH $00

STREAMSH was $7C (1)

: cmd:connect WIXSC-1

: BbsDisconnect: BBS Session closed cmdi*** COMMECTED to KIXSC-1

[IM05-2. 0k 2. X5C . 4-BIFHIMS |

You have 0 messages.

(70) »

A XSCPERN

XScperm: G messages - 6 new.

(1) >

& T SenaRecens Session window 15333
r
I~ L3 SenaRacens dagnostc race
™ L Main program 6iagnosies race (restan Outpost1s 3ppiy)

L2 SendRecens Interface data race

FYI...Log Settings has L1 selected by default
Optional: select L2 for additional info

Everything Can Be Done Manually

e Why would | want to/need to?

— Outpost is not installed or installed incorrectly; no administrative
access to PC

Browse the BBS to read bulletins

— Gain deeper understanding of how packet radio works

— Perform clean up or diagnostic activities on your setup or to maintain
the BBS

e Allyou need is a terminal emulator program
— Suggested: PuTTY (free download) https://www.putty.org/
...or just do an Internet search for “PuTTY”
— But any terminal emulator will do ...

¢ The following examples will use PuTTY \
{2
[— Select and copy: highlight/select (not <ctrl>C) ] $°

— Paste: Right-click (not <ctrl>V)

2024 Santa Clara County ARESEIRACES. Al fght

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 6
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Summary of Steps to be Discussed

¢ What you need to know to operate without Outpost
e Setting up PuTTY for BBS access (serial)
* The connection basics
— Start of shift: Configure optimized TNC settings
— Per session: Using you FCC call sign, -OR-
— Per session: Using a tactical call sign (plus your FCC call sign)
— End of shift: Restore default TNC settings
¢ Managing Messages on JNOS
— Access user and bulletin areas (mailboxes)
— Read a message
— Send a message
Reading notices and bulletins on JNOS
Working with PackltForms

What you need to know
Operations without Outpost

Connect Parameters

TNC Standard Settings and Manual Workflow
TNC User Commands

TNC Init Settings

BBS User Commands

BBS Init Settings

oV A WwN e

1. Three Connect Parameters
Operations without Outpost... need to know

o Call Sign or Tactical Call of the user
example : W6XRL4
XNDEOC

e TNC Comm Port Settings
example : COM3,9600,8,N, 1
COM?5,9600,7,E,1

e BBS Connect Name
example : W1XSC-1
W3XSC-1

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 7
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2. TNC Standard Settings
Operations without Outpost ... needto know

e SCCo RACES determined the optimum TNC parameters for our
BBS system that significantly improves message traffic
throughput.

e Document contains parameters for both Outpost and
Manual sessions. Details of each parameter are explained.

e See: https://www.scc-ares-races.org/data/packet/index.html >
Application Notes - Standard TNC Parameter Settings

... and specifically, the section titled: Standard TNC Settings
for Manual BBS Sessions

10/17/2024

2. TNC Standard Settings

Operations without Outpost ... need to know

Santa Clara Gounty ARESY/RACES i T e s

Standard TNC Parameter Settings for

FREAREY Wi Santa Clara County Packet Network

Packet BES Service Notices

£ 8131 U Bt e Come b e

Sarvice and Network Info.

Packet BBS Bacvica Dunceigtion

Application Notes.
Conigurat

1 Setop b

2. TNC Standard Settings™ e
Standard TNC Parameter Settings for
o Complete manual ops info Santa Clara County Packet Network

¢ Workflow
— Start of Shift
— Each message

— End of Shift

¢ TNC-specific Commands

Standard TNC Settings for Manual BBS Sessions

Manual Operations Workflow

TNC Commands for Manual Operati

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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3. Eight TNC user commands
Operations without Outpost (Kantronics KPC-3+)

1. HELP [command]
When entered alone, lists all available commands. With a command, provides
details on that specific command.
2. MYCALL xxxxxx
Tells the TNC what its’ call sign is.
3. CONNECT calll [viacall2, call3, ... ]
Call1 = Call sign of the station to be connected to. Adding “via call2...” connects to the BBS by
digipeaters.
4. CONVERS
Puts the TNC into Conversational mode. Then, whatever you type is immediately transmitted.
5. <ctrl>C
Puts the TNC into Command Mode. Then, enter TNC commands at the prompt.
. RESTORE DEFAULT
Resets the TNC to the factory default settings; performs the AUTOBAUD routine. Defaults
INTface to NEWUSER. Hard reset can be triggered by temporarily removing the battery.
7. INTFACE [TERM | ...]
When set to TERMinal, the full command set of the TNC is available.
8. XMITLVL [value]
~— Displays or sets the TNC’s transmit drive level

Copyright 2011-2024 Santa iara County ARESEIRACES. Al fghts reserves

10/17/2024

4. TNC Init Settings

Operations without Outpost ... needto know

¢ Go to the “Standard TNC Settings for Manual BBS Sessions”
¢ Follow instructions in “Manual Operations Workflow”

¢ Use the “TNC Commands for Manual Operations” appropriate for your
particular TNC

TNC Type Manual Ops: Start of Shift Manual Ops: End of Shift
Kantronics KPC-3+ INTFACE TERMINAL STREAMSW $7C

MONITOR

CD SOFTWARE

NEWMODE ON

RETRY 8
CHECK 30
TXDELAY 40
XFLOW OFF
STREAMEV OFF
STREAMSW $00

Copyright 2011-2024 Santa ara Courty ARESEIRACES. Al fghts reserve

5. Eight BBS user commands

https://scc-ares-races.org > Data Networking > Packet BBS > Reference > INOS BBS Information

Santa Clara County ARES/RACES INOS User Ml - Apeodix A
Home Operatons Data > Packet Trsing and Everts Refrence FAQ. Ocober 2, 2018
APPERDIX A
JNOS Packet BBS Information v -

Overview

WEXSC, WIXSC, WAXSC, WEXSC. and WEXEC.

(134

JNOS User Information

©0F -6118) ::> -
INOS Sysop Information ’

« NOS 20 wab e
oS

Notas
NOS Commands Manal
NOS Donrioads

. INOS st “nsators for
oSy
aro provided.
. nstictons
and rloase notos aro provided
« nos-bbs — TAPR xNOS Moilng List il
S by
lan Wads, GINRW (PDF -22 1B) -
356 pages, ISBN 1897840002 I
Posted here win
permssion fomthe uth .
“Tie ' the Gfivive ook on xNOS and  musthave fr any JNOS sysop. The pictre on

o 144

==

opyright 2011-2024 Santa Clara County ARESBIRACES. Al ighs
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5. Eight BBS user commands
Operations without Outpost ... needto know

1. HELP[command] or?
When entered alone, generates a summary of available commands. With a
command as a parameter, provides details on that command.
H List = shows all the List command options and what they do
2. LIST
L = by itself will display the headers for all unread messages, if any.
LA = List ALL messages, both read and unread
LM = Lists MY messages addressed to me
L> addr = Lists all messages that have “addr” in the To: field of the message

3. READ #
# = The message number to be displayed.
4. KILL #

# = The message number to be deleted.

5. AREA [ Area_name]
A = Lists all available bulletin areas.
AF = Gives a full listing with descriptions of areas.
A area_name = moves you to that area. Then use the List and Read commands
to view messages.

1t 20112024 Sarta Clara County ARESEIRACES. Al fights reserved 28

5. Eight BBS user commands
Operations without Outpost ... needto know

6. SEND [option] <dest_address>
S[P] = Send Private; example: SP wébxrl4@w5xsc.ampr.org
SB = Send Bulletin; example: SB xsctest
SC=Send Copy; to multiple destination addresses
example: SC wbxrl4@w5xsc.ampr.org
(BBS then prompts with Cc: for all other addresses)

7. BYE
Disconnects from the BBS
8. XM #

displays or sets the page length for viewing messages

6. BBS Init Settings; Page Length

Operations without Outpost ... needto know

e The BBS “XM” command displays or sets the page length
— XM = displays the current page length setting
— XM 24 = sets the page length to 24 lines
— XM O =turns off pagination (required when using Outpost)

¢ |f a page length is set, message listings, messages and other
content longer than the page length are paused and a
“More (N=no)?” prompt is shown.
— Press <ENTER> to see the next page; ‘n’ to stop
— Good for reading content on the screen
— BUT... will cause Outpost to hang if not set back to XM 0

e Note: The SCCo Packet Installer includes XM 0 in the BBS Init
Commands for all SCCo BBSs. Outpost will send XM 0 as soon
as it connects to the BBS so message output is never paused.

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 10
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SETTING UP PUTTY FOR BBS ACCESS

M Device Manager - a X

Serial Access
Setting up PuTTY

Install and run PuTTY
1. Select the Session tab
2. Select Connection Type = “Serial”

3. Enter the Com Port iR PuTTY Configuration

— Verify with Windows
Device Manager

4. Enter the Speed (baud rate)

o fener Orogn Ossi

doleta a stored session

NOTE: Not all TNCs use 9600,8,N,1
as the configuration. All fields must
match what you actually have set in
your TNC.

Set up Session Logging
Setting up PuTTY

5. Next, click on the
Session > Logging tab

2 PuTTY Configuration

6. Set Session Logging to
® All session output

7. Set up a|log file name

NOTE: &H does not work
on Windows

8. ...if the file exists:
®©Always append to the end

Why do logging at all?

« During manual operations, it is
easy to lose track of what is going on.

« Logging creates a history of your manual interactions and a reference if you
ever need to go back and check if you got it all right.

1t 20112024 Sarta Clara County ARESBIRACES. Al ights reserved
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Change PuTTY’s Backspace Key
Setting up PuTTY
9. Next, click on the
Terminal > Keyboard tab |- s
The PUTTY default does not
send the backspace key code
that the KPC-3+ expects. To
correct this:
10. Set the Backspace key
option to Control-H

Ocontor? (127)

OxtermRe.
Ovrioo- Osco

ONetHack

10/17/2024

Serial Access
Setting up PuTTY

11. Next, click on the... S e
Connection > Serial tab

12. Set Flow control to
RTS/CTS

Character Set change
Setting up PuTTY

13. Next, click on the...
Window > Translation tab

14. Change Remove characterset || =
to Win1252 (Western)

— This change matches the
default setting in
PackltForms

— PuTTY's default is UTF-8,
which works poorly with Serel
JNOS and non-ASClI il
characters.

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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Name it, Save it, and Open it

10/17/2024

Setting up PuTTY

15. Finally, click on the

Catogon;
Session tab ) Session ) Basic optionsfor your PuTTY session
i Speciy the desinaton youwantto comectto
16. Give this connection o —
aname in Saved Sessions| v SEELL il o e
17. Press Save ij::sv‘:z" Load. save or delete a stored session
. T SadSenon
Colours [MyTnc
18. Press Open to open the | & comece = TR
connection T
e Delete
Serial L b
NOTE: If you ever change Cers” Ceser @ olyoncaness
any setting, remember to
About Help [ open Cancel

press Save!

Copyright 2011-2024 Santa iara County ARESEIRACES. Al fghts reserves

THE CONNECTION BASICS

RESBIRACES. Al righs reserved

Start of Shift: Configure TNC settings

The connection basics
e TNC settings affect overall performance

— Start with the factory defaults
— Make other settings for efficient use of the BBS
¢ To be absolutely positively certain that all TNC settings are at

the current SCCo standard values, at the TNC prompt,

perform the following:
1. omd: XMITLVE (for KPC-34) to display  |EDcm |

—_— cna:
the existing transmit level <value> v smit1vl
2. cmd: INT Term (justin case) paTLvL 261
—_ cnd: restore default
3. cmd: restore default XXXXKKXDXXXXXXXKBXXXXXXXXXXXXXXXXORFE FEDF * FFFE FFFp
e ——— [PRESS (*) TO SET BAUD RATET
4. PRESS (*) TO SET BAUD RATE OO0 OO00OXBXOO0N0COBEFF” FFDE ~FEEE FFFp
y PRESS (*) TO SET BAUD RATE
5. Enter your call sign ENTER YOUR CALLSIGN=> w6xrla
6. cmd: INT Term [KANTRONICS KPC3P VERSION 9.1
—_— (C) COPYRIGHT 2002-2005 BY KANTRONICS INC. ALL RIGHTS RE:
7. cmd: XMITLVL <value> DUPLICATION PROHIBITED WITHOUT PERMISSION OF KANTRONICS.
T o er cmd:int term
8. cmd: cd software INTACE was NEWUSER
SCCo standard T1 lcnd :xmitlvl 261
9. App_ly SCCo standard TNC ) XMITIVE wos 108
settings for manual operations jcmd:cd software
jcmd:

Copyright 2011-2024 Santa Cira County ARESBIRACES. Al rights reserve

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.

13



Packet Operator Type Il

The connection basics

Start of Shift: Configure TNC settings

¢ Outpost configures the TNC at the start of each Send/Receive session
* For manual operation, you only need to send these commands once, at

8BITCONV ON
BEACON EVERY @
SLOTTIME 10
PERSIST 63
PACLEN 128
MAXFRAME 2
FRACK 6

RETRY 8

CHECK 30
TXDELAY 40
XFLOW OFF
STREAMEV OFF

Copyright 2011-2024 Santa iara County ARESEIRACES. Al fghts reserves

STREAMSW $00

the start of your shift
NOTE: Manual Ops commands are slightly different from the Outpost list of
commands.
P
TNC Type Manual Ops: Start of Shift Manual Ops: End of Shift
Kantronics KPC-3+ INTFACE TERMINAL STREAMSW $7C
MONITOR OFF
CD SOFTWARE
NEWMODE ON

10/17/2024

The connection basics

¢ Create and save a text file with the “Start
of Shift” and “End of Shift” TNC
commands.
CAUTION: Do NOT cut-and-paste
directly from the PDF into your terminal
emulator; it doesn’t always work.
**Best practice: copy the commands
first into a text editor (Notepad), save it,
and then copy-and-paste from there into
your terminal program.
¢ To send the “Start of Shift” TNC
commands,
— Connect to the TNC with PuTTY
— Select and copy the entire “Start of Shift”
command list from the text file
— Paste it into Putty (right-click) at the TNC
cmd: prompt.

Copyright 2011-2024 Santa ara Courty ARESEIRACES. Al fghts reserve

Start of Shift: Configure TNC settings

JINew Text Documentct - Notepad  — O X

File Edit Format View Help
-~ KPC-3+ Start of Shift ---

INTFACE TERMINAL
MONITOR OFF

D SOFTWARE
NEWMODE ON
8BITCONV ON
BEACON EVERY @
SLOTTIME 10
PERSIST 63
PACLEN 128
MAXFRAME 2
FRACK 6

RETRY 8

CHECK 30
TXDELAY 40
XFLOW OFF
STREAMEV OFF
STREAMSW $00

--- KPC-3+ End of Shift ---

STREAMSW $7C

Lng, Col 1t

During the Shift: FCC Call Sign Session
The connection basics
e Onthe TNC:
1. Set MYCALL to your FCC call sign
2. CONNECT to the BBS / mailbox service
(S5ID=1) on W5XSC
(D) emdimycall wéxrls
()| cmd:c woxsc-1 3. Connected message from TNC
(3)| cmd:*** CONNECTED TO WSXSC-1 e Onthe BBS:
(4)| [9w0S-2.0k.1.xsc.2-BLFHIMS] L -
(3)| You have 0 messages. 4. BBSsaysitisaJNOS BBS, version is
®) o) > 2.0k.1.xsc.2, with options
O 5. You have no messages
g ;;;DISCONNECTED 6. BBS Prompt: You are on message #0
7. Youtype “B” (bye) to terminate the
BBS session
The BBS drops the connection
N;te:_AII S(IZCo ‘BB_SsTf_\ave' e Onthe TNC:
a2 minute Inactivity Timer! 8. Disconnected message from the TNC
9. TNCis ready for the next command
opyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 42
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FCC Call Sign Session — On the Air

The connection basics

FROM TO

AX25: W6XRL4->W5XSC-1 CONNECT

AX25: W5XSC-1->W6XRL4
DATA: [JNOS-2.0k.l.xsc.2-BIFHIMS$] .You have 0 messages.. (#0) >.

AX25: W6XRL4->W5XSC-1
DATA: b.

AX25: W5XSC-1->W6XRL4 DISCONNECT
Note: Protocol codes have been removed

e FROM and TO addresses of all packets contain legal call signs

e Both stations are meeting the FCC identification requirements
with every packet (more than required)

10/17/2024

During the Shift: Tactical Call Sign Session

The connection basics

e OntheTNC:
1. Set MYCALL to your tactical call sign

©) 2. CONNECT to the mailbox service
cmd:mycall xndeoc (SSID=1) on W5XSC
(2)| cma:c wsxsc-1
(3)| cmd:*** CONNECTED TO WSXSC-1 3. Connected message from TNC
(4)| [INOS-2.0k.1.x5C.2-BIFHIMS] e Onthe BBS:
) Yj‘(; hive 0 messages. 4. BBSsays it is a JNOS BBS, version
g k() ) 2.0k.1.xsc.2, with IHM$ options
(3)| *** DISCONNECTED 5. You have no messages
(9)| cmd:conv 6.  BBS Prompt: You are on message #0
This is wéxrld 7. Youtype “B” (bye) to terminate the BBS session
end: The BBS drops the connection
e OntheTNC:
Note: All SCCo BBSs have 8. Disconnected message from the TNC
a 2 minute Inactivity Timer! 9. Enter CONVerse mode, and then type in at
least your FCC call sign, press enter to
transmit

10. Enter Cntl-C to return to Command Mode.
TNC is ready for the next command

Tactical Call Sign Session — On the Air
The connection basics

FROM TO

AX25: XNDEOC->W5XSC-1 CONNECT

AX25: W5XSC-1->XNDEOC CONNECT
DATA: [JNOS-2.0k.l.xsc.2-B1FHIMS].You have 0 messages. (#0) >.

AX25: XNDEOC->W5XSC-1
DATA: B.
AX25: W5XSC-1->XNDEOC DISCONNECT Note: Protocol codes have been removed

AX25: XNDEOC->CQ
DATA: This is wéxrld. The extra converse mode packet lets you identify
your station XNDEOC as FCC call sign W6XRL4

e XNDEOC is not a legal call sign

e Keep session under 10 minutes and use ID process at the end
of session to satisfy the FCC requirements.

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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End of Shift: Restore TNC settings

The connection basics

TNew Text Document txt - Notepad ~ — [a] X
. File Edit Format View Help
o After the BBS session has e
disconnected, you should be back to I—
the TNC command prompt, usually: MONITOR OFF
CD SOFTWARE
cmd: NEWMODE ON
8BITCONV ON
i i ini BEACON EVERY @
¢ When your shift is finished and BEACOH EVER
before you pack up the gear or turn e
it over to someone else, return the HaERAE 2
TNC to “normal” settings RETRY 8
B CHECK 30
e Cut-and-paste the “End of Shift” TaneLeY 40
Send/Receive settings into PuTTY at L g;;
the TNC command prompt
--- KPC-3+ End of Shift ---
[ STREAMSW $7C
Lng, ol 1t

MANAGING MESSAGES WITH
JNOS COMMANDS

BBS Connect & Login

e Ready to connect to BBS
e Set your call (FCC or tactical) in the TNC for login
cmd: MYCALL W6XRL4 oOr emd: MYCALLXNDEOC

e Connect
emd: C W5XSC-1

cmd ~

cmd:mycall wéxrld

° T cmd:c w5xsc-1
INOs gets login info from cmd: *** CONNECTED TO WSXSC-1

MYCALL [INOS-2.8k.1.xsc.2-B1FHIM$]

. You have 1 message - © new.
¢ No login prompt needed (#1) > €
=

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 16
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HELP
JNOS Commands

e Basic commands can be seen with HELP command

Area: woxrld (#1) » ~
hel

For a brief listing of all commands, type ?

To get help for a specific command, enter 'h command’,

The following commands have help descriptions available for them:

alias area bye connect convers download
escape finger help iheard info iproute
jheard kill list mboxuser  nodes nroutes
operator  ping ports query read register
send telnet upload verbose what xpert
zap

Area: wbxrld (#1) >

Copyright 2011-2024 Santa Clara County ARESBIRACES. Al righs reserved 49

HELP <command>
JNOS Commands

e Help with the command will give a detailed explanation

Area: wbxrld (#1) > =

help area

_LI'E Area command will list the mail areas that contain messages
you may read. It also moves you to those areas. You must be in
an area before you can read messages in that area.

A will give a short listing, whereas

AF will give a full listing with descriptions (if available).

A <areaname> moves you to that area.

AF <areaname> will give more info about just that area (if available).
AN will show areas that have new mail since you last logged off.

To read messages in one of the areas, type 'A <areanames’
You will then be told how many new, not previously listed messages
there are in this area.
You can send mail to any of the listed areas as 'S areaname’

Area: wbxrld (#1) > |

Copyright 2011-2024 Santa Clara County ARESBIRACES. Al righs reserved 50

AREA
JNOS Commands

e Messages are organized in AREAs
— Your mailbox is an area

— Bulletins: xscperm, xscevent, xsctest are each their own AREA

Alrea] gives a short listing, whereas

Area: wéxrld (#1) > 2
a
Current message area is: wéxrld

Available areas are:

wbxrld

xscperm  xscevent xsctest alllocal
allxsc allbay allnca allca allwusa allusa
allnoam  allww

Type AF to get description of areas.
AF <name> tells more about that area.

Area: wbxrld (#1) >

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 17
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AREA

JNOS Commands
AF gives a full listing with descriptions (if available)

Area: wéxrld (#1) > £

o message area is: wbxrld

Available areas are: How to
address a

wbxrld Your private mail area SCCo Notice

# Santa Clara County Op Area Shared Mailboxes

xscperm Operation, Configuration and other Permanent Info  (To: xscperm)

xscevent Emergency Incident and Public Service Event Info (To: xscevent)

xsctest Test and Training (To: xsctest)

# General Bulletin Areas by Distribution

alllocal  All categories, this BBS only (no distribution) (To: <cat>@local)

allxsc All categories, Santa Clara Co distribution (To: <cat>@xsc)

allbay All categories, SF & Monterey Bay distribution  (To: <cat>@bay)

allnca All categories, Northern California distribution (To: <cat>@nca)

allca All categories, California distribution (To: <cat>@ca) How to

allwusa All categories, Western USA distribution (To: <cat>@uusa)

allusa ALl categories, USA distribution (To: <cat>@usa) address a

allnoam All categories, North America distribution (To: <cat>@noam) I eneric

allww A1l categories, Worldwide distribution (To: <cat>@a) | ger
bulletin. Note

# <cat> A short (max 6 char) category like “equake”, "flood", "wx", ... | "

Area: wéxrld (#1) > the different

format

Copyright 2011-2024 Santa Clara County ARESBIRACES. Al righs reserved

AREA Example
JNOS Commands

e Change areas to read SCCo bulletins
— “area xsctest” — changes to the “xsctest” area

— “L” or “LA” — lists or lists all bulletins in that area
— “area <callsign>" — returns you to your own area

* CONNECTED to WIXSC-1
[IN0S-2.0K.1.X5C. 2-B1FHINS ]
You have 2 messages - 2 new.
Area: wexrla (#1) >

area xsctest

You have 1 message - 1 new.
Area: xsctest (#1) >

1

40

Mail area: xsctest

i L it
St. # TO FROM DATE SIZE SUBJECT
>N 1 xsctest xndeoc Nov 3 2627 Bulletin for Packet Type IT Classro
Area: xsctest (#1) >

|:> i
Area: wéxrld (#1) >
You have 2 messages - 2 new.

Area: wexrla (#1) >

Copyright 2011-2024 Santa Clara County ARESBIRACES. Al righs reserved

LIST
JNOS Commands

¢ Displays a list of the messages from the current mailbox
(or "area")
L - by itself will display the headers for all unread messages, if any.

LA - list all messages, read or unread

emd:c wSxsc-1 B
cmd ;*** CONNECTED to WIXSC-1
[INOS-2.0k.1.xsC.2-BLFHIMS]

You have 2 messages - 2 new.
Area: wexrld (#1) >
¢> 1
Mail area: wéxrld
2 messages - 2 new
st. # TO FROM  DATE  SIZE SUBJECT
>N 1 wexrld xndeoc Nov 2 454 XND-133P_O/R_Jelly Donut Request
N 2 wbxrld xndeoc Nov 2 443 XND-132P_0/R_Jelly Donut Delivery Ho

Area: wéxrld (#1) >

Copyright 2011-2024 Santa Cira County ARESBIRACES. Al rights reserve
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READ

JNOS Commands

e R[ead] #

¢ R[ead] <msg_number_or_range>

¢ To read a specific message, you may either type “R#" or just
the number by itself. RM will display all unread messages,

sequentially.
‘St. # TO FROM DATE SIZE SUBJECT 2
>N 1 wexrld xndeoc Nov 2 454 XND-133P_R_Jelly Donut Request

N 2 wexrla xndeoc Nov 2 443 XND-132P_R_Jelly Donut Delivery No

Area: wexrld (#1) >
E> r2

Message #2
Date: Mon, 2 Nov 2017 21:00:05 PDT
From: xndeoc@sxsc.ampr.org

To: wexrld
Subject: XnD-132P_R_Jelly Donut Delivery Notification

Donut will be delivered by 9AM
Area: wexrld (#2) >

<[

KILL
JNOS Commands

e The KILL command allows you to delete messages from your
mailbox
KI[ill] <message_number>
e At least one message number must be supplied. The message
numbers you can select from can be displayed with the
"L[ist]" command.

e Messages will not disappear until you disconnect and connect
again

Copyright 2011-2024 Santa ara Courty ARESEIRACES. Al fghts reserve

SEND

JNOS Commands
e The send (S) or send private (SP) command allows you to
enter a message and send it to a user
S[P] <user>@<domain> where
<user> = recipient’s name
<domain> = <bbscall>
<bbscall>.ampr.org
internet domain
e Send an SCCo specific Notice
SB < NoticeArea | <category>@<distribution> >
* SCCo Notices: SB < NoticeArea >
* General purpose bulletins: SB <category>@<distribution>
— As above, but ANY <user> may read the message from the mailbox.
The < NoticeArea > may be...
® xscperm
* xscevent
® xsctest

opyright 2011-2024 Santa Clara County ARESEIRACES. Al rights reserved
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Send a Message from the Keyboard
JNOS Commands
e Connect to the BBS using a terminal program

* Use these BBS commands
— SP <user>@<domain>—Send a message to a user at a specific
domain.
* When prompted, enter an SCCo standard subject
* When prompted, type the body of message
* When done, on the next line, add “/EX” and press <Enter>

1.SP <dest_addr>
2.The subject

. End with /EX or ~Z in first column (A aborts):
This is a wraparound test. 3.The message
fex 4. lex
Msg queued
(#1) >

58

Copyright 2011-2024 Santa iara County ARESEIRACES. Al fghts reserves

Send Copy
JNOS Commands
e The send copy command allows you to enter a message and
send it to multiple users
SC <user>@<domain>
e Enter the send copy command with one address

e JNOS responds with “Cc:”
— Enter other addresses to receive a copy, separated with commas

(#1) >
5C_W6xrla@nsxsc

[ f[Cc: xndeoc@usxsc, xndeoo@usxsc, xndoos@usxsc
Sunj_&%ec T .

HXM-449P R Multiple addresses
Enter Message. End with /EX or °Z in first column (“A aborts):
This is a test message with multiple addresses.

fex
Msg queued
(#1) >

Copyright 2011-2024 Santa ara Courty ARESEIRACES. Al fghts reserve

10/17/2024

BYE
JNOS Commands
e When you are all done with the BBS, disconnect from the BBS
Blye]
e On disconnecting
— Outgoing messages will be processed
— Deleted (killed) messages will be removed

il
pon’t Forget!!!
All SCCo BBSs have 2

> ol
2 minute inactwlt; timer!

opyright 2011-2024 Santa Clara County ARESEIRACES. Al rights reserved

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.

20



Packet Operator Type Il 10/17/2024

FYI... Manual message basics

Troubleshooting Hint
¢ Knowing how manual packet works will help you troubleshoot problems.

¢ Sending to one destination address:

18 *XND_1021M R Weather H.. — o

File Edit Format View Help
® sp <dest address> —————>|sp XNDO14@WIXSC
. e XND_1021M_R_Weather Heads u
<subject line> — 2|1 e B

@ To: Xanadu Station 14
<message line 1> From: County Fire
@® <message line 2> Please double-check the status of all

equipment and confirm its deployment
: readiness.
Weather forecast calls for high winds
< >
message line n and lightening tonight through
/ex<enter> sunday.

An official request for this
information will follow.
/ex

1

¢ After the SP command, the BBS prompts
for the subject, then the message.

¢ Once the *ENTIRE* message sequence is created, highlight and copy all
of it and then paste it into PuTTY at the BBS Prompt.

Copyright 2011-2024 Santa iara County ARESEIRACES. Al fghts reserves

FYI... Manual message basics
Troubleshooting Hint

Knowing how manual packet works will help you troubleshoot problems.

Sending to multiple addresses:

M *XND_1021M R Weather He.. — o b3

File Edit Format View Help
® sc <dest_address>————5 sc xnDo14@WiXsc

@ <other_addresses> > XNDB15@W1XSC, XNDO71@W1XSC, XNDOSIGHIXSC
- XND_1022M R_Weather Heads up

@  <subject line> To: Xanadu Stations 14, 15, 71, 83
<message line 1> From: County Fire
X Please double-check the status of all
® <message line 2> equipment and confirm its deployment
: readiness.
) Weather forecast calls for high winds
<message line n> and lightening tonight through Sunday.
@ /ex<enter>

An official request for this
information will follow.
‘/EX

After the SC command (Send Copy),

the BBS prompts with a CC: for additional destination addresses.

Once the *ENTIRE* message sequence is created, highlight and copy all
of it and then paste it into PuTTY at the BBS Prompt.

Copyright 2011-2024 Santa Ciara County ARESS/RACES. Al rghts re

FYI... Manual message basics
Saving the message

e There are reasons to save the message before sending it
* You have copy for your records.
* You can save all your messages before sending them.
* Avoids having to re-enter the message if something goes wrong.

e Where you save the message is up to you. But:
« If this is your PC, then save them anywhere where you can find them.
* If this is a shared PC, then create a directory on the C: Drive.

e Forinstance: your directory structure could look like this:
*  C:\MyMessages
¢ C:\MyMessages\XND-24-1009T (activation number)

e Use the message subject as the name of the file.

BUT... Manual PackitForms will do a lot of this for you!

opyright 2011-2024 Santa Clara County ARESEIRACES. Al rights reserved
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READING BULLETINS ON JNOS

Copyright 2011-2024 Santa iara County ARESEIRACES. Al fghts reserves

Bulletin Review ‘

Bulletins

e Bulletins are messages intended for a
broad audience

e The SCCo BBSs support two types of bulletins:

— Notices are a special type of bulletin specific to Santa Clara County
* Only distributed to SCCo BBSs (W*XSC)
* SCCo uses 3 special categories for specific content

— General Bulletins are globally compatible, used for everything else

* User-defined category (e.g.: “equake”, “ARES”) identifies content

* User-defined distribution controls how widely it is distributed (e.g.: “XSC”,
“BAY”, “NCA”, etc.).

e Regardless of the bulletin type, when configured in Outpost,
Outpost will automatically download them

SCCo Notice Areas NOTICE

Bulletins

e SCCo ARES/RACES has three special notice categories:

— Xscperm
* Used for notices that do not expire

e examples: standard county procedures

— Xxscevent
* Notices posted here automatically expire after 8 days

* examples: Drills, public service events, incidents, other
activations

— Xxsctest
* Good for user testing; automatically expires after 1 day

— allxsc
* Where you can write city and jurisdiction notes

* Notices posted here automatically expire after 8 days

opyright 2011-2024 Santa Clara County ARESEIRACES. Al rights reserved
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General Bulletins Overview
Bulletins

e Bulletins are messages that are intended for broad readership

e Bulletins content varies from amber alerts and earthquake
reports to jokes and recipes

e Bulletin sender controls how widely the bulletin is distributed
— Can be as narrow as “local” (this BBS only)
— Can be as wide as “ww” (worldwide!)

* In JNOS, bulletins are sorted into shared areas (mailboxes) for
easier reading

General Bulletins - Why Do They Matter?

Bulletins

e Standard way to distribute information between BBSs of all
types throughout the world

e Use them for fun or for emergency communications

e Use them for distributing information to broader areas:
— Santa Clara County

— San Francisco Bay area
— Northern California
— All California

— And wider ...

e Example:

— During the 2009 cable cut, information about anticipated service
restoration times were distributed via bulletins by a ham who had
information from the telecom carrier

General Bulletin Addresses
Bulletins

e Address format: category@distribution
e Distribution

— Asix-character or shorter keyword which defines how widely the bulletin
will be distributed
— Sender picks from a pre-defined list
— Acceptable distributions:
e local Local BBS only
xsc  XSC Operational Area (Santa Clara County)
bay San Francisco and Monterey Bay area
nca No. California (generally north of the Tahachapi Mountains)
ca California
wusa Western USA (generally, West of the Mississippi River)
usa  United States of America
noam North America (Canada, USA, Mexico, ...)
ww  worldwide

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 23
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General Bulletin Addresses (continued)
Bulletins

e Address format: category@distribution
e Category:

— Asix-character or shorter description of the main topic of the bulletin.

— Sender picks the category based on the contents of the bulletin
— Example categories:

e amber — Amber alerts

¢ equake — Earthquake reports

¢ flood — Flood reports

¢ tech —technical topics, schematics, discussion

* mty, cup, sjc, etc. — City bulletins

¢ humor or humour — jokes, stories, etc.

— Any category works on our SCCo BBSs because we sort bulletins by
distribution, not category

— Uncommon/unusual categories may be held on other BBSs until the
sysop decides where it should go

1t 20112024 Sarta Clara County ARESEIRACES. Al fights reserved
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General Bulletin Addresses (continued)
Bulletins

e Example bulletin addresses:
— mtv@xsc
* City of Mountain View information for distribution to all BBSs in
Santa Clara County

— flood@bay
* Information about flooding for distribution to all BBSs in the San
Francisco and Monterey Bay areas
— equake@nca
* Information about an earthquake for distribution to all BBSs in
Northern California
— swpc@ww
* Space Weather Prediction Center reports for distribution to all
BBSs worldwide

— humour@ww
* Variety of jokes and funny stories

Reading General Bulletins
Bulletins

e Use a terminal program like PuTTY
— Read only the bulletins of interest
— Be selective when listing and reading

e Read bulletins just like mail
— Find out what areas are available
* AREA
— Select a bulletin area
* AREA <area_name>
— List bulletins
. LA (list all)
* L> <category_name> (where category_name matches the
messages’ To: field, ex: equake )
— Read a bulletin
* R#

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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General Bulletin Example
Bulletins

1. Use “A” to change
area to “allww”

2. Wow, that’s a lot! ; E;;{uif“ messages - 160 nev D
3. Set page length 4 Em

XM 24 e .
4. List Al .
5. JNOS pauses ¢ s

— <Enter> to continue
— <N>tostop

* Note, there are multiple,
categories in the list

2
1

s1ze susaEcT

73 Salcons 2

10405 RE:Time Zomes, ete.

1434 W Update

3027 Today in History - Mar 14

4745 Geophysical Alert Message (¥WV)
eophysical Activic

Space Weather Tadices

1723 Solar Region Sumary
7408 F33105 10/2016 * GETCOW 335 +
2508 Solar and Geophysical Activity Summ

10/17/2024

wp
3 e vpaace
- tech 1938 STRAIT OF GISRALTAR
= swpc gemny 6 Flashing LED lamp driver £
» e Nyt
~ equake - | p o e Tone |
Copyr 011-2024 Santa Clara County ARESERACES. All rights reserved. 73
Bulletins
e JNOS command L> will filter the list by To: address
— Example: L>category
— ... will list only bulletins where the To: address contains category
e Example: list all earthquake bulletins
(#1) > .
15 equare
150 messages - 178 new
se. o mov  DATE  size svsgECT
¥ 7 cquake@uw  cx2sa  Mar 14 1967 SOUTAWEST OF AFRICA
¥ 19 cqueke@ww  ox2sa  Mar 15 1938 STRATT OF GISRALTAR
¥ 47 cquake@uw  ox2ea  Mar 16 1967 PULAU-PUZAY SANGTAE, TNDONESTA
¥ 96 cqueke@uw  ox2ea  Mar 18 1842 SANTA CRUZ TSLAYDS
N 103 cquake@nw  ox2ea  Mar 19 1890 ANDREANOF TSLANDS, ALEUTIAN I5., AL
N 114 cquakeuw  cx2ea  Mar 19 2015 ANTIGUA AND SARSUDA REG, IEEWARD I3
N 148 cquake@uw  ox2ea  Mar 20 2007 NEAR TAE EAST COAST OF KAMCRATRA, R
(#1) > K|
5 B -
Copyright 2011-2024 Santa Clara County ARESEYRACES. All rights reserved. 74

Read General Bulletins Like Messages

Bulletins

#1) >

> equake

e Read using st e s
theR#
ommand

To: cquake@uw
[subjecc: saNTa cruz 1stawps
Pacn: NeRME!CK25A

From: CX2SAGCX2SA.SAL.URY.S0RM
+ EQUAREGHW

hiagnsvude s 5.

18 Mar 2016

Location with respect to neazby cities:
185 km (117 mi) N of Sola, Vanuatu

611 s (378 ma) MW of Porc-vila, Vanuaca

hoze (i=sc) 2 [

FROM  DATE  SIZE SUBJECT
cx2sa  Mar 14 1967 SOUTHWEST OF AFRICA

cx2sa  Mar 15 1938 STRAIT OF G

cx2sa  Mar 16 1967 PULAU-PULAU SANGIHE, INDONESIA

Maz 20 2007 NEAR THE EAST CORST OF KAMCHATEA, R

== DRELTMINARY EARTHQUAKE REPORT ==

- SANTA CRUZ ISLANDS
orapnic coordinatest 12.4875, 166.531%
s

Tine near the Epicenter: 18 Mar 2016 17t

794 s (492 ma) ESE of Honiaza, Solomon Islands

Copyright 2011-2024 Santa Cira County ARESBIRACES. Al fights reserve
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But, what about PackltForms?

Submitted for your approval... PAZI;",ET
e You just arrived at XND Fire Station 14 to take over as ZONE
Packet Operator. This is great... Your first MAC assignment!
e Asyou enter, the last shift Packet Op rushes past you saying...
“there’s a couple of ICS 213’s on the desk to be sent!”
e At least you won’t be bored.

e Over your shoulder, you hear him yell back...
“Oh yeah, | could never get Outpost to work after IT
updated Windows... and they just left.”

The PC is running; you click the Outpost icon... Error; and you
have never seen this error before ®

OK, deep breaths. You know what to do, right?

Manual PackltForms

Fortunately, PackltForms is a message creation system designed
to work with both Outpost or as a standalone solution for forms-
based messages.
e Enhanced dale

— Manages setting up and using user and tactical IDs

— Takes care of message numbering

— Includes a Plain Text message form

— Creates a standalone 1CS-309 log

— Creates copy-ready text (all BBS commands) to paste into PuTTY

— Easy message saving
e What’s the same

— Tight integration with Outpost

— Supports all PackltForms

— Formats a standard packet form for sending

— Processes a received packet form

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved. 26
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Get ready for Manual PackltForms

Things to do before you get started:
1. Create a directory where you will save your messages.
— Consider a naming convention that is relevant for your assignment,

examples:

C:\MyMessages\XND-24-1009T (by activation number)
C:\PacketMessages\2024-10-09 (by date)
C:\Xanadu_Station_14 (by assignment)

2. ldentify a starting message number

— Assigned to you or your choice; PackItForm will append an M for
Manual to make it unique.

O 3 ThisPC > OS(C) > MyMessages
® New N Sort = v
| Drivers togs
MyMestages Mise
Logs XND-24-1009F
Misc

XND-24-1009T

Manual PackltForm messages

Manually create and send a PackltForm message
Run PackltForms with the manual.cmd

Set up your user ID, tactical ID, and other fields
Pick and fill in a PackltForm

Create the packet message

Send the message with PuTTY

o U s WwN e

Save a copy of the message

1. Running manual PackltForms

1. Open your File Explorer and navigate to
C:\PackItForms\Outpost\SCCo

2. Find the file manual.cmd, and double-click on it

- Outpost » SCCo >

Norton sanabot
PacFORMS

PackitForms

Outgest logs
= ]
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2. Set up manual PackltForm
Setup Page [Fle Edit View Higtory Bookmarks Kool Help — R
S€tup Fage
Setup loads whenever you B | sewpmo e ‘
start up manual PackltForms. C @ O Dizzoorsasrym vty & H »
3. Fillin or update all fields: Santa Clara County ARES/RACES PackltForms orsn .10
— Your user information User Call Sign: wexLe
— Tactical Call information UserName: Hersan Munster
— Select your Archive Folder Méssae I Erette aLd |63 hamchrs e
(messages are saved here)
— Select Terminal Encoding Uso Tactical Call Sign
— Next Message Number Tactical Cal Sign:, xnoe1s
Tactical Name: Fire Station 14
X148 )
FYI... The Next Message Number
will increment automatically. Archive Folder: C:\MyMessages\XND-24-1808T ]
4. Press OK when done [ox]
fight 202: unty ARE ACE: right 84

2. Set up manual PackltForm
Terminal encoding?

® Press the Terminal Encoding @help icon for details...

S =N S

Archive Folder: C:\MyMassages\XND-24-1009T L]

Terminal Encoding: pindows-1252 « (& /\

Next Message Num X [
This field indicates how your terminal software converts between characters and the binary

data that it exchanges with the BBS. For best results, configure your terminal to match this
encoding. For example:

« In PUTTY, the configuration item is "Window > Translation > Remote character set'
+ In QtTermTCP, the options are in the 'Setup’ menu.
« In converse js, the command line option is —encoding

If your terminal isn't configurable, set this encoding to match your terminal's behavior.

The recommended values are Windows-1252 (AKA CP-1252) or ISO 8359-1 (AKA Latin-1)
These convert each byte to a separate character, which makes it possible to correctly
handle multi-byte characters despite line breaks that may be inserted by the BBS

3. Pick and fill in a form

Home Page
Consists of 2 sections and a
series of controls:

$CCo PackitForms for Outpost (Public Edition) e
o Setup button: Opens the T |
Setup page. T
* Edit 1CS-309 Log: lets you [ s e = ]
make updates to the —

arecavea massage.

manual ICS-309 Log.
* Create a message to send.

haaders. You can panse,

Messaze
Choose a PackltForm unkeas |
message, then press B
Create Message
* View a received message.
Racures Dute [ sirregy ] et |

Paste in a received
message, then press
Log and View

Log sndView  esat Fekds
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3. Pick and fill in a form

Home Page e 3
5. From the dropdown « > @ 00w
menu, select a PackltForm, SCCo PackitForms for Outpost (Public Edition)

Setp | Ft 165309 Log

Croate a message 1o sena
plain text

XSC ICS-213 Message

XSC EOC-213RR Resource Request
XSC OA Jurisdiction Status

XSC OA Shelter Status

XSC Allied Health Facility Status
XSC RACES Mutual Aid Request

Messsgetpe| ] ‘i
XSC Check-In/Out Message Creste »r.ﬁ,u,‘ =

then:
6. Press Create Message [kl me— | T |
3 v Locason: ' | | & Locaton:* )
The PackItForm opens with © name O wam
— asnana v
the usual fields filled in.

Sotgoct: [

10/17/2024

3. Pick and fill in a form

Creating a message
On the selected PackItForm,
7. Fill'in the form as usual. T

MESSAGE FORM

S ot |

NOTE: The Message ID is set =

with the M suffix; wanes | i
Origin Msg #: 2 Aigtary
X14-312M

PackltForms takes care of this
for you.

8. When done, press
Create Message coc

4. Create the packet message

9. If needed, check the box if « c
this message is Urgent (1 or ) )
a Bulletin O. urisee) D esjacreiCl

@ O O 12700154

Message Page T £on Wew Figoy Govemars Jook HRp
On the Message Page, ) | sccoPackromms tor Outpost Pubi % | 14 +

10. In the To: field, —— T [NDEOC@w1xsc. scc-ares-races.org

Subject: X14-312M R_ICS213_Equipaent Status
* enter the Destination -  r—

address o form-tE 3
* multiple addresses, Mago: [X14-3124]

separate with commas.

11. When done, press
Log and Send

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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BBS Command Page

The complete packet-ready text
is ready for sending.

12. Copy the text. Put your

— From the browser menu,

4. Create the packet message

W Higtory Bookmans Toals Help

[ | SCCo PackitForms for Qutpost (Pubt X | 127.0.0.1:54873/manal-comn

« C @ O D 127.001:54873/manua

5P XHDEOC@W1xsc.Sec-ares-races.org
X14-312M R_ICS213_Equipment Status

mouse cursor in the text 15CCoPIFO!
. #T: form-ics213.html
area, and then either: #V: 3.16-2.2

Msgho: [X14-3124)
1a.: [16/14/2024]

. {17:20)
Edit > Select All 5.: [ROUTINE]
. 7.: [Logistics]
Edit > Copy 8.: [station Captain]
9a.: [Xanadu EOC)
--or enter -- Sb.: [Xanadu Fire Station 14)
10.: [Equipment Status]
— <ctrl>A <ctrl>C 12.: [All equipment is ready for deployment.]
OpCall: [WGXRL4]
(same as the menus) Opiame: [Herman Munster]

Method: [Other]

Other: [Packet]

OpDate: [10/14/2024]
17:26

Reminder: PackltForm creates OpTime: [17:26]
. |/ ADDON!
a properly formatted Subject X
line... do not change this! i i i A bt s

10/17/2024

5. Send the message

What are the Steps?

13. Make sure you previously copied the packet message from the
BBS Command Page (previous page)

14. Start PuTTY

15. Connect to the BBS

16. Once at the BBS prompt:
— Put the cursor in the PuTTY text area after the BBS prompt, and then
— Mouse right-click to paste in the message.

The complete packet-ready text is pasted into PuTTY and will start being
transmitted to the BBS.

Reminder:
All SCCo BBSs have a 2-minute inactivity timer!

Copyright 2011-2024 Santa Ciara Courty ARESBIRACES. Al fghts reserve

5. Send the message

BBS Command Page

[ Ele Edit View Higtory Bookmans Tools Help

1

] | SCCoPackitForms for O X 12700154673 manusg

ISP XNDEOCRwLx4c . §CC-ares-races. org %

1314-312M_R_ICS213_Equipsent Status 4

| |5CCoPTFO!

187 form-ics213.htal
.2

[17:20) ]
[ROUTTHE ]
[Logistics]
[Station Captaia]
.: [Xanadu EOC)

(Xanadu Fire Station 14]
[Equipment Status]
.: [ALl equipment is ready for deployment.
lopCall: [wexnLa]
|OpHame: [Herman Munster]
IMethod:
I0ther: [Pa
| opDate:
|OpTime:
1| /ADDON |
176X
U

PuTTY Screen

)_>

R
|sP
|X14-312M_R_ICS213_Equipment Status
11SCCOPIFO!
1#7: form-ics213. html

:3.16-2.2

gNo: [x14-312m]
ila.: [10/14/2024]

[17:20]

[ROUTINE]

[Logistics]

: [station captain]

19a.: [xanadu E0C]

19b.: [xanadu Fire station 14]

110.: [Equipment Status]

112.: [A11 equipment is ready for deployment.]
\opcall: [W6XRL4]

|opName: [Herman Munster]

iMethod: [Other]

1other: [Packet]

loppate: [10/14/2024]

lopTime: [17:26]

To: XNDEOCGWIXSC.SCC-ares-races.org
subject:

message. End with /EX or AZ in first column
(M aborts)

Msg_Queued

D >

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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A note on manual plain text messages

* Yes, PackltForms does support manual Plain Text message

sending and receiving. B i iy B o B )
e After picking plain text message ® | G sooge X ASCKSIMemage X SClofacitforms X
from the Home Page, the C o ol == |

Message Page opens up.
Urgent: [ Bulletin: [ i

e Message ID and Handling order
are filled in, DO NOT REPLACE THIS!

To:fr comuseparates Tist

Subject: x16-1251M_R_Equipment Status. -'
e Fillin... '
— To: destination packet address
— the rest of the Subject text ,
— Your plain text message
* Finally, press Log and Send e }
* The rest of the send process is the {
same. |
e i}
fight 202: ta Clar unty ARESE/RACH right 93

Manual PackltForm messages

Receiving messages
1. Receive messages from the BBS using PuTTY

2. Save the message

3. Once you have the message saved, delete the message off
of the BBS (use the Kill # command)

Note: All SCCo BBSs have a
2-minute inactivity timer!

Receive manual messages
PuTTY Screen ) PacklItForm Home Page

rory Bookmans Toois Heln

M10 - PuTTY = o X

*#1) > thorm for Outpost (A X 12700154873 maniai-cor

! {
Message_#1 = C ¢ o 1
D: on, 14 0ct 2024 19:30351 PST = i ot

ndx14@wlxsc.ampr.org

To: xndeoc@wlxsc
subject: X14-312M_R_ICS213_Equipment Status

1SCCOPTFO!
#T: form-ics213.html
#v: 3.11-2.2

MsgNo: [x14-312m]
la.: [10/14/2024]

1 [17:2

.t [ROUTINE]

: [Logistics]

: [station captain]

.+ [xanadu E0C]

.: [Xanadu Fire station 14]

.: [Equipment Status]

. [A11 equipment is ready for deployment]

Rec-sent: [sender]
opcall: [W6XRL4]
OpName: [Herman Munster]
Method: [Other]

other: [Packet]

oppate: [10/14/2024]
opTime: [17:26]
1/ADDON!

'SCCo PackitForms for Outpost (Public Edition)
Setup | Et 165309 Lo
Croate a message to send

Messagotype:|

Create Message

View a received mesaage
Enter the received message, inchuding the From, Subject and other headel

Received Date: 19/14/2024  Time: 19:31 {
Logand View  Reset Ficlds

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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1. Receive a packet message

10/17/2024

i COM10 - PuTTY = o =
*#1) >
. 1
Suppose at XNDEOC... Outpost is not ;essage "
used rBate? Man, 17 OCt 20747 I930:5T PSTT T T T T 77T
. |From: xndx14@wlxsc.ampr.org I
1. Connect to the BBS with PuTTY 1To: xndeoc@ulxsc ) I
A Isubject: X14-312M_R_ICS213_Equipment Status |
and retrieve a message ! !
X . ! 1sccoprro! '
2. List the message headers with LM ! 41 ¢orm-ics213.heml !
i #vi 3.11-2.2 I
3. Read the message with IMsoNo: [x14-312u] !
R # (message number) :E : [10/14/2024] !
You recognize Message #1 is a 15-: [ROUTINE] 1
17.: [Logistics] 1
PackltForm message 18.: [station captain] '
L 19a.: [xanadu EOC] |
4. Highlight all text from 19b.: [xanadu Fire Station 14] H
. R . 10.: [Equipment Status]
Date: to !/ADDON! (inclusive) 1125 [AT1 equipnent is ready for deployment] 1
. . -sent: d !
— In PUTTY, selecting text copies  |ioecanss fwevrs; '
i i lopName: [Herman Munster]
it to the clipboard INethod: [other] !
|other: [packet] '
10pDate: [10/14/2024] |
NOTE: This manual process handles 1o 177260 |
both PackitForms and plain text ';#‘1 )‘ """"""""""""""" !
>
messages. Both can be processed by
pasting them into the Home Page.
pyright 2011-2024 Sar lara nt S Al rights reserved 96
2. Recover the PackltForm message
Tie £1 Wew Vipoy Bockrens Toos 560 3
E i
Home Page - 1
(] ¢ Outpst P X 1210015487 Himanial-tommon]
Back at the Browser, get back to the {
« C @ Q D 2700
SCCo PackltForms tab

5. Putyour cursor in the “View a
received message” section and
enter <ctrl>V or Edit > Paste to
paste in the received message.

6. Press Log and View.
— This entry is logged to the ICS 309

— The received PackItForm is opened in
its PackItForm.

— A copy of the message is saved
7. Once the PackItForm is opened,
print and hand it off for delivery.

'SCCo PackitForms for Outpost (Public Edition)
Setup | Et 165309 Lo
Croate a message to send
Measage type: | -

Create Message

View a roceived message

Enter the received message, inchuding the From, Subject and other headel

Recerved Date: 19/14/2024  Time: 19:21
Logand View  Reset Ficlds

Sidebar: A Note on Outpost tags

* Messages sent from Outpost occasionally have “tags”
inserted in messages that you might see.

e Some of the more common tags are:

— IRRR! Request Read Receipt

— IRDR! Request Delivery Receipt

— ISCCoPIFO! This is a PackltForm message
— 1/ADDON! The end of a PackltForm or other Addon message
— IUG! Mark message as urgent (lists as RED in the Outpost listing)

e PackltForms will ignore many Outpost tags that it sees and
they will not show up in the message.

© Copyright 2011-2024 Santa Clara County ARES®/RACES. All rights reserved.
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What about the saved messages?

Take a look at your C:\MyMessage\X14-24-1009T\ manual message
directory (or whatever you named it).

The message’s Subject field is used for the file name.

Clicking on the “Name” column header sorts messages by file name.

Clicking on the “Date Modified” column header sorts by file timestamp.

These views can help with managing your messages.

Submit a copy
of this directory

[ —

10/17/2024

with your t 5 Windows (C) > MyMessages > X14-23-1008T

paperwork MyActivations

when done. Mytddom EOC-1245P_R_Report Station_Staff Status.xt 1071412024 16:07 A
WMyhcasages X14-310M_R_Check-In XNDO14, Fire Station 14.txt 1011412024 16:12 AM.
Logs X14-312M_R_ICS213_Equipment Status it 1011412024 17:20 AM
isc X14-317M_R_ICS213_72 hour stafing plan.txt 1071412024 18:15 AM
Kid2a-1008T X14-319M_R_EOC213RR_Xanadu Complex Fire bt 10/1412024 18:02 AM
vy X14-321M R_Surprise Pizzaxt 1071412024 18:23 PM

X14-325M_R_Check-Out XNDOT4, Fire Station 4.6 10/14/2024 18:12 PM
MyMsgs3 LR
fight 202: ta Clar unty ARESE/RACE right 99

What about the ICS 309?

¢ Manual PackltForms comes with its own ICS 309 Log, similar to what
Outpost does.

* From the PackltForm Home Page, when you click on Log and View ,
you write a new ICS 309 Log entry for this message.

¢ From the PackItForm Home Page, when you click on | Edit ICS-309 Log |,
you open the ICS 309 form for editing and printing.

100

« All fields are editable. e —_— Z = S
* Required fields are o —— — t
highlighted in RED. PRyl

Deletes this line from the
Comm Log

Adds another line as a

manual entry.

Erase All - clears the

form. Also, Undo Erase

All - restores the form.

Generate CSV File —

creates a .csv file of the

n_check-1n o002, Kiss

owezz  xaz-iam  [owsecen R_ics313_opening status
xndeociwi . 00-3001F 00822  k22-1244  [R_ICS233_open

owezz  xaz-am [woeocen

Comm Log. e S S
e Print—prints the Comm  [#:3¢  [mosis  xaesim  footecea
lo9:37  |cndeoc  eoe-szase ac
Log to the selected A b
printer. Py
* Save — Saves any changes [ ]
you made. 195 309500 ARESRAGES (o 202
PIF:11 .
gurign 20112024 Sania Cara County ARESEIRACES T TT
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Manual packet operations; not many changes
This is a tool change, not a process change

1. First Shift...
a. Show up, request a safety and assignment briefing
b. Find a workspace for your packet operations
2. Initial station setup...
a. Find, assess, and set up the packet station
b. equipment check-out
3. Packet Operations...
a. Download notices, send yourself a test message
b. Send the formatted check-in message with your Tac Call
c. Manage the message flow
4. Incoming Shift Change...
a. Request a safety and assignment briefing
5. Outgoing Shift Change...
a. Archive the event documentation
6. Securing Operations...
a. Send the formatted check-out message with your Tac Call
b. Archive the event documentation
¢, Shutdown

102

10/17/2024

Amateur Packet Radio
Field Reference, Type Il B

Amateur Packet Radio

e Taking a quick look inside Field Reference, Type Il

Table of Contents
1  QUICK REFERENCE.....
2 INTRODUCTION November 2023
21 Puspose i
22 HOW TO USE THIS HANDBOOK
23 OTHER REFERENCES ...ovecusnninenin
MANUAL PACKET OPERATIONS
31 TNCComMmANDS..
32 BBS CommanDs... 5 i
33 Connecting TO THE TNC wimi PUTTY L.
34 START OF SHIFT: ConriGURE TNC SETTINGS .
35 END OF SHIFT: RESTORE TN%SErwos
36 GETTING READY FOR MANUAL MESSAGING
37 MANUAL MESSAGE BASICS .....oo.ooeocein
3.8 S5eNDING A PACKITFORM MESSAGE MANUALLY.
39 Receving A PACKITFORM MESSAGE MANUALL
310 VIEWING SAVED MESSAGES ........oieuoeisceioeanecin
3.11 Noreson ManuaL ICS 309 Comm LoG ...

For SCCo RACES Responders

@

@

bt

e et b o s

103

Could manual packet ops really happen to me?

* Better to be safe than sorry... Build your USB packet
thumb-drive now!

T
.
Directories (suggested) S—
— x:\Programs
Putty installer (https://www.putty.org/)
Putty (https://www.putty.org/ > Alternative binary files)
SCCo PackitForm Directory (C:\PacktForms\Outpost\SCCo)
SCCo Packet Installer - https://www.scc-ares-races.org/data/packet/client-software.html
SCCo PIFO-only Installer (<download_dir>\sccsetup163Cpub_includes\SccoPIFOsetup3. 16pub.exe)
Office Libre Portable version (https://www.libreoffice.org/download/portable-versions/)
— x:\SCC Notices
« downloaded text version
* Archive of the Outpost SCC Notices
directory to reload if necessary
— x:\TNC Init files - x:\Docs
* text version, seven total KPC3 TNC Manuals
- x:\Miscellaneous County References... (https://www.scc-ares-
o Pre-defined messages to be edited races.org/data/packet/index.htmi)
prior to sending JUNoifFe'fTLen;e:R dio Field Ref, Type IlI
o * Unofficial Packet Radio Field Ref, Type
x:\MyMessages\<event> « Unofficial Packet Radio Field Ref, Type Il
« Orwhatever directory name you choose.

104
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10/17/2024

Questions?

105

WRAP UP

106

First things first

e Online Class Evaluation

— Log into https://www.scc-ares-races.org/activities/events.php
Click “Submit Class Evaluation” in Events

]
Log.Out < of Events i
Activitles Home Show: Current events ® Past events Event Descriptions {
SCC ARES/RACES Home 1
Comments/Bugs
Events | Packet -TypeII- Adv /T {

st Events By Date Date: Start: Type q
List Events 1 Joined Al * L « ning Y
Create o New Event Course Details: Click here to visit the course description and download the{
Detets an Event [

= EC/AEC Council Meeting

List/Print an Event Roster -
start: q

Date: Type:
Subemlt Class Evaluation "D - " Hoiial g t idl l”t fes, best
My Brofil ] Purose: Discuss orgonizational snd management ksas, srategles; best p

. e i D e il

— Submit your evaluation as soon as possible... after 1 week, the form
will no longer be available for this class!

oputaht 2011:2024 Sarta Clra County ARESSIRACES. Al rigts reserved 107
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Exercise Scenario

* You've been dispatched by the Xanadu EOC to provide
communications for a field location.

— Your tactical Number: #1# (Assigned by your instructor)
— Your tactical call: XNDO## (Assigned by your instructor)
— Your Message Prefix: X## Where “##" are the last two

. digits of your tactical call
— Your assighment Name: Xanadu Post ##

— Operate using your home city’s primary or secondary BBS.
— The EOC'’s tactical call is XNDEOC on W1XSC
e You arrive at your assignment and set up the station but
discover that Outpost on the packet PC does not work! Looks
like you need to do all packet operations manually.

e Your assignment was mailed to you ahead of time.

1t 2011.2024 Saria Clara Counly ARESEIRACES. Al righis reserved 108

Thank You!

Please complete the Course Evaluation
on or before next Saturday 9-November!

Please complete the Assignment
on or before next Saturday 9-November!

Office Hours:
Sunday, 3-November, 3:00p to 4:30p (zoom)
Wednesday, 6-November, 7:30p to 9:00p (zoom)

If you have questions or feedback about this or other training activities,
you can join our packet discussion group.
https://scc-ares-races.groups.io/g/packet

Questions, comments, suggestions?
knépe@arrl.net
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